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ABSTRACT 

 
The cochlea is a fluid-filled coil of the inner ear that transforms sound waves into 

electrical signals for processing in the brain. The mammalian auditory system is most 

commonly studied using the mouse, Mus musculus, due to anatomical similarities of the 

cochlea between auditory generalists, such as mice and humans. Auditory specialists, such as 

bats, exhibit unique resistance to age-related hearing loss, or presbycusis. This adaptation 

enables bats to navigate while flying with echolocation throughout their lifetime. Studying 

comparative cochlea anatomy can aid in understanding specializations of the mammalian 

auditory system and hearing loss among species. There is a significant gap in available 

educational resources for comparative cochlea anatomy focusing on bats and mice.  

The purpose of this project was to develop an interactive educational resource for 

comparative cochlea anatomy of the big brown bat, Eptesicus fuscus and Mus musculus with a 

3D overview animation depicting labeled cochlea models. Segmentations of histological and 

micro-CT data were modified and sculpted to build idealized anatomical models suitable for 

teaching purposes. A separate section of the interactive allows the user to explore comparative 

cochlear anatomy of bats and mice as related to hearing loss. The user interface and 

interactivity were coded to allow exploration of bat and mouse cochlea regions and intuitive 

navigation between sections about specific anatomical structures and bat hearing loss research. 

The results of this project provide a didactic and accessible visualization for auditory 

researchers, graduate students, and lay audiences to review basic cochlear anatomy, compare 

cochlear anatomy of bats and mice, and strengthen their understanding of human age-related 

and noise-induced hearing loss.  

Jamie Lynn Peterson 
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INTRODUCTION 

  

Cochlea Overview 

The cochlea is a fluid-filled coil of the inner ear located in the petrous portion of 

the temporal bone. The apex of the cochlear spiral points rostrally towards the mandible, 

while the base points towards the external ear to receive sound vibrations. The role of the 

cochlea is to transform sound waves from the middle ear into electrical signals for 

processing in the auditory system of the brain. The cochlea is surrounded by the bony 

labyrinth and otic capsule, within which the membranous labyrinth houses the cellular 

structures that detect incoming sound frequencies.    

The interior of the otic capsule is sectioned into three fluid-filled chambers or scalae 

(Figure 1). The uppermost chamber is the scala vestibuli, the middle chamber is the scala 

media, and the lower chamber is the scala tympani. At the base of the otic capsule are two 

membrane-covered windows that are open to the middle ear ossicles. The oval window is 

in contact with the foot of the stapes at the base of the scala vestibuli while the round 

window is at the base of the scala tympani (Robles, 2001). The scala vestibuli and scala 

tympani both contain perilymph fluid and join together at the helicotrema of the apex of 

the cochlea. The scala media is filled with endolymph fluid (Slepecky, 1996). The scala 

media is separated from the scala vestibuli superiorly by Reissner’s membrane and 

separated from the scala tympani inferiorly by the basilar membrane. The lateral wall of 

the scala media is formed by the stria vascularis, which is attached to the spiral ligament. 

The scala tympani ends at the round window, while scala media and vestibuli continue 

beyond the cochlea base to the vestibular system of the inner ear (Slepecky, 1996).    
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The membranous labyrinth contains the cellular structures of the organ of Corti. 

The organ of Corti is housed within the scala media and spirals along the basilar membrane 

from apex to base. The organ of Corti’s cellular structures consist of the receptor cells, 

inner hair cells, outer hair cells, and supporting cells. Inner hair cells are flask-shaped cells 

that are aligned in a single row and topped with stereocilia (Kössl and Vater, 1995). Outer 

hair cells are cylindrical-shaped cells that are arranged in rows of three and are topped with 

three rows of stereocilia. Outer hair cells are thought to enhance the sensitivity and 

selectivity of the cochlea and participate in efferent pathways that protect the cochlea from 

sound-induced trauma (Raphael, 2003, and Kössl and Vater, 1995; Fuchs and Lauer 2019).  

At the base of the inner hair cells are numerous afferent nerve endings from type I 

spiral ganglion neurons. These nerve fibers carry signals to the brain for processing. 

Approximately 80-90% of afferent endings connect at the inner hair cells via the spiral 

ganglion, while the remaining percent end at the outer hair cells as type II spiral ganglion 

neurons (Kössl and Vater,1995, Vater, 2000). At the base of outer hair cells, efferent nerve 

fibers connect to a single large terminal (Kössl and Vater,1995). The supporting cells of 

the organ of Cori are non-sensory cells that consist of Henson, Claudius, Pillar, Deiters, 

and Bottcher cells that create a rigid scaffolding for the outer hair cells (Kössl and 

Vater,1995). 

The organ of Corti rests on top of the basilar membrane (Figure 2). The basilar 

membrane moves in response to the arrival of sound waves, causing the hair cells’ 

stereocilia to brush against the tectorial membrane (Vater, 2000). The movement of the 

sensory hair cells creates electrical signals that travel to the brain for processing via the 

auditory nerves. Hair cells along the basilar membrane are stimulated by different 
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frequencies. Low-frequency sounds stimulate hairs cells in the apex of the cochlea, while 

high-frequency sounds stimulate hair cells at the base (Vater, 2000). Damage to the cochlea 

plays an essential role in the onset of presbycusis or age-related hearing loss. The loss of 

sensory hair cells and damage to the nerve fibers over time causes age-related hearing loss 

in most mammals.  

 

                 
Figure 1. Membranous cochlea structures of the big brown bat, Eptesicus fuscus. Histological slide of 
specimen G16_L (Table 1). SV, scala vestibuli; SM, scala media; ST, scala tympani; RM, Reissner’s 
membrane; SV, stria vascularis; SL, spiral ligament; TM, tectorial membrane; OC, organ of Corti; BM, 
basilar membrane; SG, spiral ganglion. 

 

Bat and mouse cochlea anatomy 

The mammalian auditory system is commonly studied using the mouse, Mus 

musculus, as a model organism for understanding noise-induced and age-related hearing 

loss in humans due to anatomical similarities of the cochlea. The goal of this research is to 

develop and assess animal models for both normal and pathological features of hearing in 
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order to make comparisons with human hearing. This approach is called “comparative 

hearing research”, which studies the structures, physiological functions, and hearing 

abilities of various species in order to determine the essential principles of how structures 

determine function, and aid in clarifying the evolution of hearing among animals (Fay and 

Popper, 1993).  

While mice are frequently used as the animal model for researching noise-induced 

and age-related hearing loss, bats are rarely used as models for studying hearing loss, 

despite their presumed resistance to noise and age-related damage. The bat cochlea is 

comprised of the common mammalian set of sensory and supporting structures, however, 

it has adapted mechanisms for sound transmission and frequency evaluation to 

accommodate for a frequency range far above humans (Vater, 2000). Unlike mice and 

humans, bats exhibit a unique resistance to noise-induced and age-related hearing loss. A 

specially adapted auditory system allows bats to navigate using echolocation for flying, 

hunting, and roosting throughout their lifetime (Vater, 2000). To understand prevention of 

acquired hearing loss in humans, the science community is beginning to look to bats as 

model organisms for the mammalian peripheral auditory system.  

It has long been assumed that bats are unaffected by loud noise exposures and 

hearing loss. However, new research shows that the big brown bat, Eptesicus fuscus, can 

develop hearing loss due to a combination of stressors including malnourishment, housing 

stress, inbreeding, and exposure to noise pollution in captivity (Retta et al., 2019). 

Comparing cochlear morphological differences between the big brown bat and mouse is  

useful for studying protections against hearing loss (Figure 3). The big brown bat is an 

auditory specialist that has a higher and broader range of hearing compared to the house 
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mouse, Mus musculus, an auditory generalist. There are remarkable variations in cochlea 

structure between these two species.  

Comparing skull dimensions helps to envision the size difference of the two 

species. Skull size of Eptesicus fuscus is ~18.5mm in length and ~12.5mm in zygomatic 

width (Albrecht, 2003) compared to the Mus musculus skull length of ~21.0mm and width 

of ~11.0mm (Cory, 1912). Comparing cochlea size to the dimension of the skull, the 

Eptesicus fuscus cochlea is proportionality much larger.  

 

 
Figure 2. Skull and cochlea coil measurements.  
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Unpublished data from the Lauer Lab in the Center for Hearing and Balance at 

Johns Hopkins University School of Medicine show that the coil length of Eptesicus fuscus 

is approximately 6-7mm from base to apex compared to Mus musculus coil length of 

approximately 5mm. Cochleae can also be measured by the number of turns, Eptesicus 

fuscus cochlea has ~2.5 turns (Vater, 2000) compared to ~2.0 turns in Mus musculus 

(Slepecky, 1996). The extra half turn of the big brown bat cochlea supports a broader 

hearing range. Based on observations in the Lauer Lab, the axis of the big brown bat’s 

cochlea is more ventrally oriented compared to the mouse. 

There are also membranous and cellular structural differences between the cochleae 

of Eptesicus fuscus and Mus musculus. The basilar membrane of Eptesicus fuscus is overall 

longer, narrower, and thicker compared to Mus musculus (Kössl and Vater, 1995). This 

increases the stiffness of the membrane, allowing for sensitivity to higher frequency signals 

(Kössl and Vater, 1995). Sensory hair cell adaptations of Eptesicus fuscus include shorter 

outer hair cells and stereocilia compared to Mus musculus, a specialization thought to 

increase sensitivity to higher frequency sounds (Kössl and Vater, 1995 and Mao et al., 

2017). Studying comparative cochlea anatomy can aid in understanding specializations of 

the mammalian auditory system and differences in susceptibility to hearing loss across 

species. 
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Figure 3. A visual summary of the cochlea membranous structures of Eptesicus fuscus. The illustration 
shows the cochlea regions discussed in this project.  
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Interactive comparative anatomy in education  

 It is challenging to visualize the three-dimensional structure of the cochlea using 

two-dimensional images and histology slides alone. Available interactive educational 

resources are limited to human cochlea anatomy, such as “The Interactive Ear: A Guide to 

Human Hearing” (Amphilon) and “Anatomy.tv” (Informa UK Limited). There are no 

interactive cochlea educational resources available on mice or other species despite the 

frequent use of animal models in mammalian auditory system research. Discussions with 

graduate students and researchers at Johns Hopkins University revealed a need for an 

interactive resource that would offer depictions of cochlea anatomy comparing bats and 

mice.  

Depictions of cochlea anatomy of bats and mice are found in the literature and 

include supporting images, histological sections, and illustrations. Textbooks such as 

Hearing by Bats (Popper et al., 1995), Comparative Hearing: Mammals (Fay et al., 1994) 

and The Cochlea (Dallos et al., 1996) present descriptions, illustrations, photographs, 

histological sections, and detailed information on the mammalian cochlea. However, these 

resources lack interactivity for the learner. Some written resources compare the cochleae 

of the horseshoe bat (Rhinolophus), frog-eating bat (Trachops cirrhosis), little brown bat 

(Myotis lucifugus), and short-tailed fruit bat (Carollia perspicillata) to other mammals 

including mice, rats, gerbils, Guinea pigs, cats, and humans (Popper et al., 1995). There is 

a gap in available educational resources for comparative cochlea anatomy and visual side-

by-side comparisons of Eptesicus fuscus and Mus musculus.        
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 Computer-based interactive imagery, also known as interactive educational 

modules, can help students to develop mental images and understand spatial relationships 

of anatomical structures (Khalil, 2005). Interactive images are dynamic and allow students 

to control the influx of information at their own pace. Students can self-test, self-question, 

and self-evaluate their learning through the use of interactive labels, images, and models. 

Interactive educational modules that implement the use of 3D models, images, or 

animations depicted along with 2D images help the student to visualize structures in 3D 

(Yammine, 2014). Although formal reports on the efficacy of interactive imagery in 

facilitating learning are limited in number, interactive media is thought to help users 

develop new learning skills, allow students to practice recall and self-regulation, and may 

support and promote independent life-long learning (Khalil, 2005).  

 Learning theories of instructional design can provide valuable insight into how 

educational resources can best aid learners in understanding complex material like 

comparative anatomy. During this project several learning theories were taken into 

consideration when creating the interactive and animated material. Mayer’s Cognitive 

Theory of Multimedia Learning (Mayer, 2003 and Mayer, 2014), Bruner’s Constructivist 

Theory (Clark, 2018), and the learning concept of Interactive Imagery Strategy by Khalil 

(Khalil, 2004) are learning theories and strategies that were utilized in the design of this 

project.  
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Objectives 

 Three main objectives directed the development of this project: 
 

1) Communicate cochlea anatomy of Eptesicus fuscus and Mus musculus by creating 

an interactive educational resource and 3D cochlea overview animation. Ensure 

accessibility of the interactive to allow diverse audiences to review basic cochlear 

anatomy, as well as compare cochlear anatomy of bats and mice. 

2) Develop 3D cochlear models to enable accurate mapping and high-quality data 

visualization of cochlear damage and hearing loss in bats due to inbreeding, 

malnourishment, and environmental noise pollution. 

3) Promote the significance of bat age-related and noise-induced hearing loss research 

and its potential impact on strengthening the understanding of human age-related 

and noise-induced hearing loss.  

 

Audience 

The primary audience is auditory researchers, neuropathologists, and graduate 

students studying the mammalian auditory system. The secondary audience is an educated 

lay audience interested in mammalian cochlear anatomy and age-related and noise-induced 

hearing loss. 
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MATERIALS AND METHODS 

 

User interface design and 2D assets 

 Grayscale wireframes were developed in Adobe Illustrator and Photoshop during 

the early planning of the interactivity and content organization of the educational 

interactive, Appendix A. The preliminary wireframes helped to determine the layout, 

design, page navigation, content, and assets needed for the interactive. The 2D vector assets 

were designed referencing histological slides and 3D micro-CT data and then created in 

Adobe Illustrator for Adobe Animate. The vector assets were imported into Adobe Animate 

2019 for the creation of the interactivity. The developed 2D interactive contains three main 

sections: Overview Animation section, Cochlea Anatomy section, and Normal vs Deaf Bat 

section. Secondary pages in the dropdown menus consist of Cochlea Location, Cochlea 

Structures, Cochlea Section, Organ of Corti, Damage Data, and Damage Mapping.  
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3D assets  
Sources of data 

 Segmentations of micro-computed tomography (micro-CT) datasets of two 

Eptesicus fuscus specimens were obtained through a free digital repository, 

MorphoSource.org. Specimens included one female skull dataset with 462 images and a 

separate mandible set with 313 images each with a z-axis slice interval thickness (distance 

between images) of ~20µm. One male full body dataset with 200 images with a slice 

thickness of ~40µm was also segmented (Table 1). MorphoSource is hosted by Duke 

University Research Computing server to allow universities and research institutions to 

upload and organize unpublished data projects for research and public use. The Eptesicus 

fuscus datasets were uploaded to MorphoSource by researchers at the University of 

Michigan Museum of Zoology (Project: Digitizing Extant Bat Diversity).  

The segmentation of a micro-CT dataset of a female Mus musculus skull scanned 

at ~40µm was obtained from another free digital repository, Digital Morphology, hosted 

by The University of Texas at Austin (digimorph.org). Additional Eptesicus fuscus and 

Mus musculus micro-CT datasets were provided by the Department of Engineering, 

Whiting School of Engineering at Johns Hopkins University and Pound Human 

Identification Laboratory at Johns Hopkins University. Segmentations of these datasets 

were modified to create the idealized Eptesicus fuscus and Mus musculus skulls and 

cochlea models for educational purposes (Table 1).  

Sequential 30µm histological slides of Eptesicus fuscus and Mus musculus were 

provided by the Lauer Lab in the Center for Hearing and Balance at Johns Hopkins 

University School of Medicine. These sagittal histological slides consist of one deaf 
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Eptesicus fuscus specimen, one normal Eptesicus fuscus specimen, and one normal Mus 

musculus specimen for structural comparison. Segmentation of the histological slides were 

used for reference in the creation of the interactive assets (Table 2).  

 

Data Type Identification 
Name/Number 

Source # of 
Slices 

Source 
Location 

Purpose 

Eptesicus 
fuscus 

micro-CT, 
Skull 

M18423 MorphoSource.org 462 University of 
Michigan 
Museum of 
Zoology 

Segmentation 

Eptesicus 
fuscus 

micro-CT, 
mandible 

M18424 MorphoSource.org 313 University of 
Michigan 
Museum of 
Zoology 

Segmentation 

Eptesicus 
fuscus 

micro-CT, 
full body 

iDigBio: 110759 
MorphoSource: 
M53150 

 

iDigBio.org 
MorphoSource.org 

 

2000 University of 
Michigan 
Museum of 
Zoology 

Segmentation 
Skull 

Eptesicus 
fuscus 

micro-CT, 
head 

Eptesicus Inner 
Ears 

Department of 
Mechanical 
Engineering 

 
970 

Johns Hopkins 
University, 

Whiting School 
of Engineering 

Segmentation 
Cochlea and 
semicircular 
canals 

Mus musculus  
micro-CT 

MorphoSource:
M13514 

MorphoSource.org 685 Pennsylvania 
State University 

Segmentation 
Cochlea and 
semicircular 
canals 

Mus musculus  
micro-CT 

1903_F Pound Human 
Identification 
Laboratory 

822 Johns Hopkins 
University, 
SOM 

Identification 
Laboratory 

Segmentation 
Cochlea, 
semicircular 
canals, and 
skull 

Eptesicus 
fuscus STL, 
Skull 

M18423 MorphoSource.org - University of 
Michigan 
Museum of 
Zoology 

Reference 

Eptesicus 
fuscus STL, 
mandible 

M18424 MorphoSource.org - University of 
Michigan 
Museum of 
Zoology 

Reference 

Mus Musculus 
STL, skull 

TMM M-3196 Digimorph.org - The University 
of Texas at 
Austin 

Reference 

Table 1. Skull and Cochlea datasets. Compiled list of data including type, species, location, and intended 
purpose of the data collected.  
 

 

 



 

 15 

Histological 
slides 

Identification 
Name/Number 

Source # of Slices Source of 
Location 

Purpose 

Eptesicus 
fuscus, Normal 

G16_L 
 

Lauer Lab, 
JHU, SOM 

48 Johns Hopkins 
University, 
SOM 

Segmentation  
membranous 
structures 

Eptesicus 
fuscus, Deaf 

Brown24_L Lauer Lab, 
JHU, SOM 

39 Johns Hopkins 
University, 
SOM 

Segmentation  
membranous 
structures 

Mus musculus, 
Normal 

P20599_L Lauer Lab, 
JHU, SOM 

28 Johns Hopkins 
University, 
SOM 

Segmentation 
membranous 
structures 

Table 2. Histology data collection. Compiled list of data collected including species, location, and intended 
purpose of the data collected.  
 

Overview of software 

Numerous software packages were used throughout this project to segment and 

manipulate the data, create 2D and 3D assets, and develop the 2D interactive and 3D 

animation. 3D Slicer (version 4.10.2, Fedorov et al., 2012) was used to view volumetric 

micro-CT datasets of Eptesicus fuscus and Mus musculus and create segmentations of 

selected cochlear structures. Reconstruct (version 1.1.0.0, 2007) was used for histological 

slide stacking, alignment, and structure segmentation. Pixologic ZBrush 2019 was used to 

modify, sculpt, and idealize bat and mouse skulls, cochleae, and cochlea structures. Maxon 

Cinema 4D (C4D) (version R20) was used to manipulate and repair the 3D models further. 

MeshLab (v.2016.12) was used to optimize the 3D models for ZBrush and 3D animation 

in C4D.  

Information architecture diagrams for the 2D interactive were created with Adobe 

Illustrator and Photoshop 2020. Wireframes for the 2D interactive (Appendix A) and 

storyboards for the 3D animation (Appendix B) were created in Adobe Illustrator and 

Adobe Photoshop 2020. Illustrator and Photoshop were also used for creating the 2D 

illustration assets used for the interactive module for Adobe Animate 2019. 
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Segmentation in 3D Slicer 

 Volumetric datasets were imported into 3D Slicer for segmentation. 3D Slicer is an 

open-source software program for medical image processing and three-dimensional 

visualization of volumetric datasets (Kikinis, 2014). Segmentations were added by clicking 

the Add Data widget in the upper left corner or by clicking File > Add Data. Within the 

Add data into the scene window, the dataset was added by selecting Choose File(s) to 

Add. Before importing the data, Show Options was clicked, and Single File was 

unchecked.  

 Segmentation was performed using the Segment Editor module of 3D Slicer after 

importing the volumetric data. The data can be viewed in three windows: (A) coronal, (B) 

sagittal, (C) axial. Manual segmentation of the cochlea from Eptesicus fuscus and Mus 

musculus cranium was preformed instead of using the automated process. After loading the 

data, the Segment Editor of Slicer was selected in the top menu bar, and the Add (+) button 

was clicked to create a new empty segmentation layer. The coronal view was used to create 

the initial segmentation of the cochlea. The Paint tool, shortcut 1, was used to paint the 

desired area of the cochlea (Figure 5). The cochlea was painted every ten slices by 

navigating through the slices with the view slider. A live 3D view of the segmented area 

was turned on periodically to check the resulting surface by clicking Show 3D. The 3D 

view was turned off while segmenting to avoid slowing of the software operations. To 

clean up the segmentation slices, the Eraser tool, shortcut 3, was used to remove undesired 

and overpainted areas.     
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Figure 5. Left cochlea segmentation of Eptesicus fuscus in 3D Slicer. (A) Axial, (B) Sagittal, (C) Coronal, 
(D) live 3D views. The green painted area is shown in the orthogonal views as slices. Text within image not 
intended to be read. 

 

 The Fill between slices tool was used to connect the segment slices and create a 

3D surface of the segmentation. The Initialize button, under Fill between slices displayed 

a preview of the calculated 3D segmentation. Clicking Apply turned the segmentation into 

a 3D surface. To create a complete segmentation of the exterior cochlea and the 

semicircular canals, painting in multiple views was required. 

Segmentations of the axial and sagittal views were created using the same painting 

method and Fill between slices to create 3D segmentations. Painting in multiple views 

ensured that the whole cochlea was segmented, however, all three segmentations needed 

to be painted and filled separately and then combined to create a complete cochlea 

representation. The Add operation under Logical operators was used to combine the three 

segmentation views into one complete external cochlea shape (Figure 6).  
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Figure 6. Left cochlea segmentation after Fill between slices and Logical operators. The Paint tool and 
live 3D view are active, this model is the completed external cochlea segmentation after Fill between slices 
and combining segments from all three views. Text within image not intended to be read.  

 

 Threshold was used to generate a clean surface model of the cochlea and 

semicircular canals from the initial segmentation. To segment out the cochlea and 

semicircular canals, a new segment was created in the Segment Editor. Threshold was set 

to auto-> maximum and the threshold range slide bar was used to fine tune the selection 

targeting the fluid-filled chambers of the cochlea and semicircular canals. The Editable 

area was restricted to the original segmentation before applying the threshold to create a 

complete cochlea and semicircular canal model of the fluid-filled chambers.  
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Figure 7. Left cochlea segmentation threshold of inner cochlea chambers. Results of thresholding inside 
the cochlea in axial and 3D views. Unwanted surface fragments were removed using the Eraser tool, shown 
in yellow. Text within image not intended to be read. 

 

 The cochlea surface model needed additional cleaning and repair after 

Thresholding. Undesired small surface fragments around the model were removed 

automatically using Islands > Remove small islands. Larger fragments connected to the 

cochlea surface were removed using the Eraser and Scissor tools on the axial, sagittal, 

coronal, and 3D views using the Sphere brush (Figure 7). Additional segmentations needed 

to repair the model were created using the Paint tool and combined with the cochlea 

surface model using Logical operators to fill holes and missing semicircular canal sections 

(Figure 8).  

 Cochlea segmentations completed in 3D Slicer were exported as STL files by 

clicking the drop-down menu arrow beside the Segmentations… button and selecting 

Export to files…. Each segmented layer was saved as an STL. The cochlea STL file was 

imported into C4D and ZBrush for further sculpting and repair.  
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Figure 8. Left cochlea segmentation of inner cochlea chambers. Results after cleaning the surface of 
specimen, Brown24_L. The whole cochlea and semicircular canals shown in pink. Text within image not 
intended to be read. 

 

Segmentation of Eptesicus fuscus cochlea from the Whiting Engineering 

Department involved extra preparation for 3D Slicer segmentation. The micro-CT dataset 

needed recalibration to include z-axis slice interval thickness and image resolution data. 

The dataset was stacked by importing the files in Adobe Photoshop under File > Scripts > 

Load Files into a Stack. The images were sorted by name to ensure that the files were in 

order before stacking. Once the images were stacked, they were saved as a DICOM file 

and imported into Horos for recalibration. 

In Horos, the file was opened in 3D Volume Rendering. The calibration numbers 

were entered into the dialog box for Pixel X and Y resolution and Slice interval. The slice 

interval thickness was calculated by taking the z-axis coordinate of the first image of the 

sequence and subtracting it from the last z-axis coordinate in the stack. This number was 

divided by the total number of images to get the slice interval thickness in micrometers. 

The Pixel X and Y resolution numbers were found in the log document from the scans and 
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were converted to micrometers (Figure 9). The calibration allowed a 3D volume 

reconstruction. The calibrated data was exported as a DICOM file and was added to 3D 

Slicer for segmentation of the cochlea.  

 

              
Figure 9. Recalibration window in Horos. The calculated calibration numbers used to prepare the Johns 
Hopkins Eptesicus fuscus specimen for segmentation in 3D Slicer. 

 

Segmentation of histological slides in Reconstruct 

 Reconstruct is a free editor for Windows PCs designed to assist with montaging, 

aligning, analyzing, transforming, and displaying data of histological slides, also known as 

serial sections (Fiala, 2005). Before segmentation of cochlea structures, the serial sections 

needed to be imported, aligned, and locked into place following the instructions from the 

Reconstruct User Manual (Fiala, 2009) (Figure 10).  
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Figure 10. Reconstruct tools work screen. A slide is aligned using the orange dots as alignment markers. 
The sections panel to the left shows the slides that have been aligned and locked using the red lock icon. The 
tools palette and the stamp shape palette are shown to the right. Text within image not intended to be read.  

 

                                  
Figure 11. Reconstruct tools palette. Highlighted in red are the Drawing Freehand tool and Pan and Zoom 
tool. Draw Freehand tool was used to trace the cochlea structures. Pan and Zoom tool aided in navigation 
and zooming into the histology slide for tracing.        
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 Segmentations of the cochlea structures were created using the Draw Freehand 

tool in the Reconstruct tool palette (Figure 11). This tool allowed for controlled tracing 

around the desired structure using a mouse or tablet stylus to fill the shapes with assigned 

colors. Segmentation of the cochlea structures included: sensory cells of the organ of Corti, 

tectorial membrane, spiral ligament, basilar membrane, Reissner’s membrane, stria 

vascularis, and the spiral ganglion (Figure 12). The middle mouse scroll button was used 

to navigate up and down through the serial sections for segmentation.  

The Zoom and Pan tool was used to zoom into structures by holding the right 

mouse button and dragging the mouse up and down (Figure 11). The structures were traced 

individually using the Draw Freehand tool on each serial section. Each structure was 

assigned a different color and name under the Series > Series Options > Names/Colors, 

for segmentation organization (Table 3). The process of segmentation was completed for 

three specimens, one deaf and one normal Eptesicus fuscus, and one normal Mus musculus 

separately.  

 
Structure Sensory 

cells 
Tectorial 
membrane 

Spiral 
ganglion 

Basilar 
membrane 

Reissner’s 
membrane 

Stria 
vascularis 

Spiral 
ligament 

Color 
Code 

Yellow Orange Purple Green Teal Red Pink 

Table 3: Color coding table for Reconstruct segmentation. Each structure was assigned a color for 
organization and recognition between the specimen.  



 

 24 

  
Figure 12. Reconstruct segmentation of the cochlea. Finished result of segmentation tracing of all the 
structures from specimen P20599_L, normal mouse. Object panel on the left lists the structures and the 
number of slides traced to each structure. Text within image not intended to be read. 

 
After segmentation was completed, a 3D scene was generated to view the 3D 

representation of the structures (Figure 13). The structures were added to a 3D scene to be 

manipulated by clicking Object to open the object window and selecting Add to Scene 

under List Objects > select the structure name > Scene. The surface model was adjusted 

under preferences Series > Options > 3D. The model settings were changed to Boissonnat 

surface. The Biossonnat setting gave the 3D representations a smoother surface. Repeating 

the 3D scene process created representations of the structures listed. Selecting all the 

structures and refreshing the 3D Scene window displayed all the structures together and 

showed the anatomical relationships between them.  

Complete cochlear structures were exported through the 3D scene window by 

selecting Scene > Export and selecting VRML 2.0. The Virtual Reality Modeling 

Language (VRML 2.0) file extension allowed the surface model to be imported into C4D 

for further model manipulation.  
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Figure 13. Reconstruct segmentation and 3D Scene. The 3D Scene shows specimen, G16_L. Normal bat 
structures are highlighted as 3D representations of the tracings. (A) shows Reconstruct screen with the result 
of the segmentation in the small windows (B) Close up of the 3D representation of the traced structures. Text 
within image not intended to be read. 

   

Creation of 3D models 

1. Optimizing surface exports  

Before sculpting in ZBrush, the models derived from micro-CT data were 

optimized to remove segmentation arifacts in MeshLab using Quadratic Edge Collapse 

Decimation under Filters > Remeshing, Simplification, and Reconstruction > 

Simplification: Quadratic Edge Collapse Decimation (Figure 14). Optimizing the 

models in MeshLab removed mesh errors and decreased the number of faces significantly. 

The optimized models were ready for sculpting and repair in ZBrush.  
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2. Importing histological surfaces 

The structures in the VRML 2.0 files were imported into C4D as polygon objects. 

The structures were exported under File > Export > STL for ZBrush.  The STL file was 

imported into ZBrush by selecting Zplugin > 3D Print Hub > Import STL.  Separation 

of the models in ZBrush was performed using Polygroups (Figure 15). Under 

Polygroups, the Auto Groups button separated the structures into different Polygroups 

within one Subtool. The Polygroups were separated into individual Subtools by selecting 

Tools > Subtools > Group Split. Each structure could then be duplicated and renamed 

before sculpting and repair as an independent Subtool.   

 

           
Figure 15. Reconstruct segmentation surface imported into ZBrush, Brown24_L, deaf bat. Results of 
separating the structures into individual subtools for repair and sculpting. Each subtool is separated, 
duplicated, and renamed.  
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3. Sculpting in ZBrush 

The optimized segmentation surface models were brought into C4D. The skulls and 

cochleae came in aligned in anatomical position and as separate objects. In C4D, the project 

scale was increased by 10x, turning the models from 10cm to 100cm. Increasing the scale 

of the models helped to prevent sculpting issues in ZBrush due to the original skulls’ small 

dimensions. 

The eleven surface models for the big brown bat and ten surface models for the 

mouse were imported into ZBrush for sculpting, smoothing, repairing of holes, and other 

modifications to transform the data into idealized models of the craniums and cochleae of 

both species. The optimized big brown bat and mouse craniums and cochleae were 

imported into ZBrush using the GoZ plugin. Under Plugins > C4D_PyGoZ-master > 

Export to ZBrush. GoZ is a plugin that bridges ZBrush with other 3D packages for model 

creation. GoZ aided in keeping the same project scale when moving back and forth between 

C4D to ZBrush. GoZ also helped to keep the skulls and cochleae in anatomical position 

when moving between the programs (Figures 16 & 17). 

Before the models were modified in ZBrush, duplicates of each model were created, 

renamed, and brought into Dynamesh mode to prepare the surfaces. The mandible of the 

bat was scanned separately from the cranium and required manual aligning using the 

Gizmo 3D tool. The two subtools were then merged to create a complete skull (Figures 16 

& 17). 
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Figure 16. Alignment of cochleae in skulls, lateral view. Cochleae are in anatomical position, shown in 
red. (A) Eptesicus fuscus complete with mandible aligned, (B) Mus musculus. 

 

 
Figure 17. Alignment of cochleae in skulls, inferior view. Cochleae are in anatomical position, shown in 
red. (A) Eptesicus fuscus, (B) Mus musculus.  

 

The skull and cochleae models had artifacts from segmentation that needed to be 

addressed. The big brown bat skull had holes and missing sinus anatomy. To remove the 

small fragments of the sinuses, the skull was selected, and Auto Groups was clicked to 

create different Polygroups (Figure 18). Holding the Shift + Control keyboard keys 

together and clicking on the model hid the fragmented sinus Polygroups. The hidden 

Polygroups were deleted using the Delete hidden feature followed by Close Holes button.  
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Figure 18. Removal of sinuses using Polygroups. Damaged sinuses, in pink, were selected and turned into 
a new polygroup for deletion.  

 

The bat skull had hole artifacts from segmentation that needed to be repaired. The 

geometry around the holes was selected using the SelectLasso tool and hidden by holding 

down Shift + Control + Option. The holes were deleted and closed using the Delete 

Hidden and Close Hole buttons. The main brushes used to refine the models were the Clay 

Build Up, Move Topological, Smooth, and Damian Standard brushes to reinforce detail 

and textures lost with smoothing and closing holes. Move Topological was used over the 

Move brush because it does not affect the mesh on the unseen side of the model. Large 

regions missing in the skull were repaired using sphere subtools that were moved, scaled, 

merged, and Dynameshed to the skull to fill large holes. Repairs to the mouse skull were 

completed using the same method. 

The histological structure models were modified separately from the skull and 

cochlea models. The models needed numerous modifications including sculpting, 

smoothing, trimming, and hole repair. After duplicating and Dynameshing the models, the 

geometry and holes were repaired using the SelectLasso tool, Delete Hidden, and Close 

holes process. After segmentation, the models were trimmed using the Trim Rectangle 

brush to a create uniform ends for the models (Figures 19-21).  
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Figure 19. Segmented histological 3D models of Brown24_L, deaf bat. (A) 3D models from Reconstruct 
imported into C4D, (B) Resulting 3D models after clean-up and repair in ZBrush. 

 

 
Figure 20. Segmented histological 3D models of G16_L, normal bat. (A) 3D models from Reconstruct 
imported into C4D, (B) Resulting 3D models after clean-up and repair in ZBrush. 

 

 
Figure 21. Segmented histological 3D models of P20599_L, normal mouse. (A) 3D models from 
Reconstruct imported into C4D, (B) Resulting 3D models after clean-up and repair in ZBrush. 
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4. Repair and artifact removal 

The big brown bat cochlea model was missing a large section of the internal spiral 

wall that could not be repaired in ZBrush due to reversed normals. The model was exported 

to C4D for repair. The normals were reversed by selecting all polygon faces and selecting 

Mesh tab > Normals > Reverse Normals. To locate defects, the outer surface of the 

cochlea was hidden using the Hide Selection tool under the Select menu with Only Select 

Visible Elements enabled. Mesh Checking was activated by hitting Shift+M on the 

keyboard and clicking Enable Mesh Checking to identify Non-manifold and Boundary 

edges.  

The defective polygons were deleted using the Live Selection tool. Deletion of the 

polygons did not delete the vertices; to ensure the vertices were deleted, Mesh menu > 

Commands > Optimize was selected. The holes were filled using the Polygon Pen tool 

to connect the vertices and create new geometry. The resulting large polygons were 

subdivided to create more geometry, under the Mesh menu selecting Commands > 

Triangulate and then Mesh > Commands > Subdivide. The model was smoothed using 

the Sculpt tools in Sculpt mode after the holes were closed. The repaired model was 

exported back to ZBrush using GoZ for final sculpting and smoothing of the cochlea 

(Figures 22 & 23).  
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Figure 22. Bat cochlea models before and after repair in ZBrush and C4D. (A) Anterior view before 
repair, (B) anterior view after repair, (C) cross section of cochlea with holes, (D) repaired cross section.  

 

                             
Figure 23. Mouse cochlea models after repair in ZBrush. (A) Anterior view before repair, (B) posterior 
view before repair, (C) Anterior view after repair, (D) posterior view after repair. 
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3D Animation 

 The bat and mouse skulls, whole cochleae with semicircular canals, and idealized 

cochleae were optimized for C4D in ZBrush. Each model’s polygon count was reduced 

using the Decimation Master in the Zplugin menu. Each model was pre-processed before 

decimation. The percent of the decimation was adjusted using the % of decimation slider. 

A decimation percent of forty was chosen to reduce the number of polygons down and still 

keep detail. The models were imported to C4D using the GoZ plugin to ensure the models 

stayed in anatomical position.  

In C4D, the materials were created and applied, lighting was set up, and movement 

of models and cameras were keyframed. Model animation sequences were rendered 

separately for each model and saved as PNG files. The rendered sequences were imported 

into Adobe After Effects for compositing. Translucency effects and transitions were 

created by animating masks and opacities of the different layers. Leader lines and labels 

were created in After Effects. Other 2D assets were created in Adobe Illustrator and 

Photoshop and imported into After Effects as individual assets for the animation.  

The animation was rendered from Adobe Media Encoder 2020 and uploaded to 

YouTube for Closed Captioning (CC). CC was added automatically under 

Subtitles/Closed Captioning. Editing options for CC can be found in the Video Manager. 

Add new subtitles or CC button and change language > create new subtitles or CC 

was selected. This generated CC can be edited by adding new text boxes to break up 

sentences by hitting the + button. Text can be changed to correct any auto subtitle 

mistakes, punctuation, and timing issues.  
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2D interactive educational module 

Summary of interactivity  

 This web-based interactive resource was designed to have three main sections: a 

section containing a pre-rendered Overview Animation, Cochlea Anatomy, and Normal vs 

Deaf bat research pages (Figures 44-53). Under the Cochlea Anatomy section are 

secondary pages for Cochlea Location, Cochlea Structures, Cochlea Section, and organ of 

Corti that contain comparative cochlea anatomy information. Dropdown pages under the 

Normal vs Deaf section, Damage Data and Damage Mapping, are for learning about bat 

hearing loss research and the purpose and process of cochlea damage mapping in research.     

 

Interactivity in Animate 

1. Coding in Animate 

The 2D interactivity was created in Adobe Animate 2019. Adobe Animate is a 

vector-based computer animation program used to make interactive websites, web 

applications, and video games published using the HTML5 (Hypertext Markup Language 

5) platform. The project was created as a HTML5 file for manual coding of buttons and 

elements. Publish Settings were set up before the module could be exported. Animate 

settings were changed by selecting File > Publish Settings > Basic, and unchecking Loop 

Timeline.  Under Image Settings, Combine image into spritesheet was checked to help 

speed up publishing.  

The assets were imported to the stage and converted into symbols by selecting the 

art, right-clicking, and selecting Convert to Symbol to name the symbol (Figure 24). Each 

symbol also needs an Instance name for identification in the code. All the assets were 

imported, converted to Symbols and given Instance names with specific capitalization for 
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animation when clicked. By default, all the assets in the file will show at the same time 

when published and need to be coded in the ActionScript menu as alpha=1 and visible= 

true; to show the art or alpha=0 and visible = false; to ensure the unwanted art is hidden 

when the module is opened. Each page button is assigned the desired artwork to show when 

clicked and the artwork that remains hidden. Calling the correct page button within the 

“navBar” symbol to target the correct artwork, requires layered coding as shown in 

Appendix C, Buttons. Inside the curly brackets {}, the code for the art was placed for 

calling or keeping the art hidden when the button is clicked.  

Each button and annotation cue was coded to be a pointer. This turns the mouse 

arrow icon into a hand icon indicating the button is active and clickable; refer to Appendix 

C, Buttons for coding cursors. All the buttons were coded for MouseOver and MouseOut 

demands as well. This fades the buttons to 50% when the cursor hovers over them and 

changes them back to 100% when the cursor moves off of them.   

 The anatomical structures in each section were assigned small circular annotation 

cueing elements for the user to click on for more information on the structures. A total of 

34 annotations were coded for the 17 key structures of the cochlea. Each cue and annotation 

was turned into a Symbol and Instance and named after its structure for organization. Each 

cueing element was coded to call up one annotation and to turn off all other annotations 

when clicked, refer to Appendix C, Annotations. Two sets of cueing elements were 

needed for the bat and mouse cochleae to allow the user to click on either set and view the 

annotations.  
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2. Creating animated elements 

Creating animations in Adobe Animate requires nesting of all the artwork within 

one large symbol for organization and coding purposes. Within the large symbol 

“MouseHead”, for example, the artwork was separated into multiple symbols and instances 

of the bat and mouse skulls, cochleae, and structure labels for keyframing and Tweening. 

New frames are added to the animation using the F5 button, frames help to organize and 

control the elements of the animation (Figure 25). Keyframes can be added using the F6 

button, keyframes indicate where a new symbol instance will appear on the timeline. The 

artwork can be keyed to scale, rotate, move, or fade on and off between keyframes.  

 

 
Figure 25. Keyframes and Tweening in Animate. Example of keyframes and Tweening in Adobe Animate. 
Purple bars are the added Tweens between the keyframes for smooth animation. Text within image not 
intended to be read. 

 

The bat and mouse cochleae were animated to rotate and enlarge while the skull 

artwork disappeared. Tweens were created to allow the symbol properties to be constrained 

between the keyframes and play over time, a Classic Tween was used for all the animated 

elements. Easing the animation smoothed the movements between keyframes. With a 

frame within the Tween selected, Properties menu > Tweening > Classic Ease was 

selected to change the ease. 
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In Adobe Animate, the animations play on a continuous loop automatically when 

published. Adding a script layer and coding keyframes within the animation will stop the 

animation from looping. The first keyframe was selected and the code this.stop(); was 

added in the ActionScript menu to prevent the animation from playing automatically when 

published and allow for coding of a button to play the animation. In order for the animation 

to be activated, a Start label was added to the first keyframe of the animation for the code 

to the animation. The cochlea animation was coded to be played when the Cochlea 

Structure button under the Cochlea Anatomy dropdown menu is clicked, refer to Appendix 

C Buttons for animation coding.  

 

Hosting for Web 

 The interactive module was hosted on jpetersonillustration.com. A link was 

added to the Lauer Lab website, www.lauerlab.com. The interactive folder containing 

the FLA, HTML, and JS files was added to the WordPress server. In the WordPress 

administration website, a page was built to house the interactive. After the files were 

uploaded, the module could be loaded in a web browser by targeting the module (e.g. 

sitename.com/name_of_app/index.html).  
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RESULTS 

 
2D Assets 

A total of 72 bat and mouse assets were created and imported into Adobe Animate, 

including portraits, skulls and silhouettes, whole cochleae, half cochleae, cross sections, 

organ of Corti, damage data and mapping illustrations, buttons, icons, and annotations 

(Figures 26-28). The interface consisted of 13 buttons containing the assets. A total of 33 

interactive annotations were made for the 17 essential cochlea structures the interactive 

highlights. Refer to Appendix C for examples of Adobe Animate code. 
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3D Assets 

 Completed 3D models include skulls of Eptesicus fuscus and Mus musculus 

(Figures 29 & 30), cochleae with semicircular canals (Figures 31 & 32), cochleae without 

semicircular canals (Figures 33 & 34), and three models containing seven membranous 

structures from three sets of serial sections (Figures 19-21).  

 The complete Eptesicus fuscus and Mus musculus skulls, cochleae with and without 

semicircular canals were created as educational sculpted models based a segmented micro-

CT data. These sculptures were incorporated into the Overview Animation and used as 

reference material for the 2D assets of the educational module. The surface segmentations 

of serial sections created from one deaf Eptesicus fuscus, one normal Eptesicus fuscus, and 

one normal Mus musculus served as reference material for designing the 2D assets for the 

membranous structures of the cochleae.  
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Animation stills 

 
Figure 35. Animation still, Opening title.  

 

 
Figure 36. Animation Still. Audio: The big brown bat, or Eptesicus fuscus, is an auditory specialist with a 
broad hearing range and high sensitivity to ultrasonic signals used for echolocation. 
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Figure 37. Animation Still. Audio: The house mouse, or Mus musculus, is an auditory generalist with a 
comparatively limited hearing range.  

 

 
Figure 38. Animation Still. Audio: There are remarkable variations in cochlear structure between these two 
species. The cochlea is a fluid-filled coil of the inner ear located in the petrous portion of the temporal bone. 
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Figure 39. Animation Still. Audio: The apex of the cochlear spiral points rostrally towards the mandible, 
while the base points towards the external ear to receive sound vibrations. The axis of the big brown bat’s 
cochlea is more ventrally oriented compared to the mouse. 

 
 

 
Figure 40. Animation still. Audio: The cochlea transforms sound waves into electrical signals for 
processing in the brain. It is attached to the semicircular canals, which record the angular velocity of head 
movements to maintain balance.   
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Figure 41. Animation still. Inside the cochlea, different sound frequencies stimulate sensory hair cells along 
the basilar membrane. Lower-frequency sounds stimulate hair cells in the apex and higher-frequency sounds 
stimulate hair cells in the base.  

 
 

 
Figure 42 Animation still. Audio: The length of the coil of the big brown bat is approximately 6-7mm 
compared to that of the mouse, which is approximately 5mm. The extra half turn of the big brown bat cochlea 
supports a broader hearing range.  
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Figure 43. Animation still. Studying comparative cochlear anatomy can aid in understanding auditory 
specializations and hearing loss in mammals. 

 
 

 
Figure 44. Animation still. End Credits. Text within image not intended to be read. 
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Web-based comparative interactive design and deployment 

The user can view the animation and 3D models by clicking on the Overview 

Animation button on the home screen. The complete interactive and animation was 

uploaded onto a website containing all the necessary Adobe Animate files, HTML/CSS 

files, Javascript files, and image files, except the pre-rendered animation, which was hosted 

on YouTube.com. The animation was created to provide a 3D visualization of the 

anatomical differences between Eptesicus fuscus and Mus musculus cochleae and provide 

three-dimensional context to the familiar two-dimensional imagery within in the 2D 

interactive module and histological slides. 

The Overview Animation page contains the data-driven 3D models with didactic 

2D elements. The interactive assets found in the education module are contained under the 

pages accessed via the Cochlea Anatomy button. The dropdown pages include the Cochlea 

Location button with the cochlea inside the skull and labels, the Cochlea Structures button, 

which starts the cochlea animation with labels, and the Cochlea Sections button, which 

depicts structures within one-half turn of the cochlea and the Organ of Corti with 

interactive annotations (Figures 50 & 51). The Damage Data button under the Normal vs 

Deaf dropdown menu, accesses histological slides with accompanying didactic 

representations of the slides (Figure 52). The Damage Mapping button accesses 

information on the process and purpose of mapping cochlea damage of deaf big brown bats 

(Figure 53). The Cochlea Section and Organ of Corti interactive annotations allow the user 

to click on the membranous structures of the cochlea to discover the structures’ name, 

location, function, and allow for future self-testing.  
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Comparative interactive design stills 

 

   
Figure 45. Interactivity Cochlea Home Screen page. Text within image not intended to be read. 

 
 

  
Figure 46. Interactivity Overview Animation page. User can choose to start the overview animation; 
new window will open for YouTube.  
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Figure 47. Interactivity Cochlea Anatomy page. Cochlea Anatomy page shows the external ear anatomy 
for reference of location.  

 
 

    
Figure 48. Interactivity Cochlea Location page. User can observe the cochlea in anatomical position. The 
drop-down menu for Cochlea Anatomy is shown.  
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Figure 49. Interactivity Cochlea Structures page. Cochleae animated from the skull to the scientific view 
with labels and measurements.  

 

 

   
Figure 50. Interactivity Cochlea Section page. A section of the cochlea is enlarged to observe the 
membranous structures. Each white circle is a cuing element with an annotation. This screen shot shows the 
annotation for Reissner’s membrane. Text in image not intended to be read. 
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Figure 51. Interactivity Organ of Corti page. The organ of Corti is enlarged from the cross section and the 
nerve fiber annotation has been clicked. Text in image not intended to be read.  

 
 

   
Figure 52. Interactivity Damage Data page. Illustrations of normal and deaf bat accompanied by 
histological slides from the Lauer Lab depicting bat hearing loss research.  
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Figure 53. Interactivity Damage Mapping page. Illustrations depict damage mapping based on 3D 
reconstructions of histological slides. A description of damage mapping and methods is shown to the left 
with a link to the Lauer Lab for access to more research.  Text in image not intended to be read. 

 
 

   
Figure 54. Interactivity Information button. Information about this project, resources and a link to the 
Lauer Lab for more information on bat hearing research. Text in image not intended to be read. 

 

 



 

 62 

Access to assets resulting from this thesis 

 The assets resulting from the work of this thesis can be accessed in part at 

jpetersonillustration.com or by contacting the author through the website’s contact form. 

The author may also be reached through the Department of Art as Applied to Medicine 

graduate program via the website medicalart.johnshopkins.edu.  
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DISCUSSION 

 
Project goals  

The primary goal of this project was to fill a gap in the educational material on 

comparative cochlea anatomy by creating an interactive web-based resource. 3D models 

developed from segmentation of micro-CT data were employed in an animated overview 

of the interactive content. The animation introduces Eptesicus fuscus and Mus musculus 

cochleae to serve as a guide for studying the anatomy, spatial relationships, and physiology 

of sound. The interactive content that follows the animation allows the user to explore 

comparative cochlear anatomy of bats and mice as related to hearing loss. The results of this 

project provide graduate students, researchers, and lay audiences with a novel didactic tool 

for visualizing and understanding cochlea anatomy and learning about bat hearing loss 

research.   

 

Segmentation and 3D model creation 

Reconstruct is a free software package for serial stacking and segmentation. Two 

methods of segmenting histological slides in Reconstruct were investigated, each of which 

yielded different results. While the Draw Freehand tool method was chosen, the second 

method for segmenting is the Trace palette tool. For this method, a shape stamp is selected 

and used as a marker for structures. Clicking on a region of interest in several areas through 

the serial sections will leave markers that are mapped and calculated in Reconstruct to 

create a 3D representation of the structure. This method is useful for alignment of 

histological slides and damage mapping, but the Trace palette tool does not accurately 

trace the boundaries of structures.  
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The results of histology segmentations were useful for understanding the 

relationship of the cochlea’s structures and viewing them in three-dimensions. However, 

the resulting 3D models yielded no details of smaller structures, such as the sensory hair 

and supporting cells, and were missing a significant amount of surface geometry. In the 

future, exploring other programs for histological serial section reconstruction may yield 

higher quality surface models that could be used in 3D animation or interactive media.  

Three-dimensional data that provided the basis of the idealized models included a 

full surface segmentation of one Eptesicus fuscus and one Mus musculus dataset. Lower 

resolution of the Mus musculus dataset yielded imprecise semicircular canals that needed 

significant repair and sculpting. The resolution of the Eptesicus fuscus dataset yielded 

higher quality cochlea and semicircular canal surfaces. In the future, segmentation of 

multiple specimens with consistent resolutions would allow for identification of anatomical 

variations and reduce the amount of sculpting needed to repair models. 

 

2D interactive comparative module 

 Adobe Animate uses vector art to create interactives and websites. Importing vector 

assets from Adobe Illustrator has a few limitations. If directly importing from Adobe 

Illustrator, assets must not have transparencies, blurs, drop shadows, gradients, and all line 

work needs to be converted into shapes. Importing assets from Illustrator to Animate also 

caused a color shift, desaturating the original artwork. Saving each asset as a PNG file 

solved these issues and allowed transparencies, drop shadows, gradients, linework, and 

colors to remain the same as designed. Turning the assets into PNGs also helped to maintain 

a smaller file size in Animate, which allowed a faster publishing time.  
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Organization of Symbols and Instances is important to proper HTML code calling. 

In order to keep track of the numerous Instance names and Symbols for coding of the assets 

in Animate, a chart of Instance names for all assets, buttons, and annotations was created 

to refer to during coding in the ActionScript panel. In the future, investigating alternative 

programs with plugin platforms for building 2D interactives would be more efficient than 

coding all elements from scratch in Adobe Animate. 

 

3D Overview animation 

 The introductory Overview Animation was created to provide a concise, narrated 

comparison of labelled Eptesicus fuscus and Mus musculus cochlea models. These didactic 

explanations aim to allow viewers to make stronger spatial connections between the 3D 

models and information they have learned from 2D images in the available mammalian 

cochleae literature. Showing the cochlea models from numerous views conveys their full 

structure and position within the skulls. The use of animated labels aids in highlighting 

important cochlea structures and anatomical differences between the two species.  

 

Accessibility 

 The interactive is accessible in any web browser. The user can revisit the website 

and access the animation and interactive at any time for cochlea anatomy review. The user 

interface was designed for easy navigation between sections with large section buttons and 

dropdown menus for access to other pages through one click by the user. For color blind 

viewers, use of the color white for cueing anatomical annotations creates high visual 

contrast against the structure to allow for easy targeting (Figure 50). The interface was 
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tested using a color-blind simulator, Coblis, to ensure that all text and colors of structures 

were legible. For hearing-impaired users, Closed Captioning transcripts are available for 

the animation on YouTube.  

                  

Implications for education and biocommunication 

This project used volumetric and histological data as a basis for sculpting 

educational cochlea models that can efficiently communicate information on mammalian 

cochlea anatomy and clarify the artwork in the 2D interactive. The structures were refined 

for use in a didactic animation with integrated audio. Learning theories and strategies 

related to instructional design provided guidelines and principles for presentation and 

organization of the project’s content.   

Mayer’s Cognitive Theory of Multimedia Learning focuses on how learners use 

words and pictures to process information. In general, people process information more 

efficiently when images accompany text. The use of dynamic text, such as labeling and 

color-coding, improve the learner’s connection between the image and the text. Multimedia 

Learning is based on three principles: 1) learners have two channels to process information, 

auditory and visual; 2) learners have a limit of how much information can be taken in by 

each channel; 3) meaningful learning is attained if the information is relevant, organized, 

and connects to prior knowledge (Mayer, 2003). These strategies were implemented in this 

project to provide the user with information and images without being overwhelming. 

These principles were considered while creating the 3D overview animation. In the 

animation, cueing elements such as labels and arrows were timed with the audio and visuals 

to emphasize the structures and their importance. Cognitive Load is the total amount of 
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mental effort used by working memory for learning (Paas et al., 2010). The overview 

animation was created to provide information and visuals before the interactive, to 

construct prior knowledge about cochlea structures and functions. Labels were placed close 

to corresponding structures to reduce learner’s cognitive load and facilitate learning. 

Bruner’s Constructivist Theory emphasizes learning as being an active process and 

based on the student’s willingness to learn. Learners are constructing new ideas and 

concepts as they connect learning material to past knowledge. This theory focuses on the 

learner playing a central role of controlling their own learning and seeking knowledge 

independently (Clark, 2018). After viewing the cochlear anatomy animation in this project, 

the user can explore the interactive educational module, controlling the flow of information 

at their own pace and self-testing their new knowledge on cochlear anatomy. This project 

is directed towards learners who are interested in clear and concise information on 

comparative cochlea anatomy and bat hearing loss research. The users are motivated to 

learn the content so that they can be involved in comparative research related to the cochlea. 

Through interaction with the module, the user is actively transforming and exploring 

information on their own.  

Khalil’s Interactive Imagery Strategy involves the utilization of web-based, dynamic 

instructional images such as illustrations, photographs, or models to convey information. 

Dynamic images are combined with interactive elements, such as labels and color coding. 

These images allow the user to control their learning. The strategy stipulates that 1) images 

should be clearly labeled, 2) labels should be interactive to allow students to self-access, 

3) color-coding should be employed to help make connections, and 4) multiple views of 

structures are key to spatial learning (Khalil, 2004). The use of 3D models or providing 



 

 68 

models from multiple views helps with spatial learning and structural relationships (Khalil, 

2004). The overview animation in this project provides the user with different views of 3D 

models to help with understanding the relationship of the cochlea within the skull and the 

structure of the cochlea. The 2D interactive offers dynamic labels for the structures, 

allowing the user to self-test and promoting independent thinking.   

 

Future Directions 

This thesis created a novel workflow for the production of an interactive 

comparative educational module and the creation of accessible and data-driven 3D cochlea 

models from segmentation. Future development of the project could focus on additional 

3D cochlea models, and full implementation of a 3D interactive educational resource for 

comparative cochlea anatomy. Future 3D models including the middle ear ossicles, a 

sagittal cut of the cochlea to reveal the membranous structures, and 3D models of the organ 

of Corti with interactive structures could be developed.  

An additional section to the module that includes an adult human cochlea compared 

to Eptesicus fuscus and Mus musculus would be beneficial for auditory and comparative 

cochlea anatomy research. Making the 3D cochlea and skull models available to the public 

using a 3D model sharing platform would allow researchers and the public access to 

manipulate and download models for 3D printing or viewing.  
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User testing 

User testing is a necessary component in developing an interactive module to 

ensure accessibility, navigation, and success in learning content. The interactive module 

was shown to graduate students and researchers in the Lauer Lab during the final stage of 

the project. The team provided feedback on the navigation, accessibility of the content, and 

organization of the interactive module and overview animation. The user testing ensured 

that the annotations were presented in an engaging way for the learner.  

As a result of the user feedback, changes were made to the project. The largest 

change was the incorporation of interactive 3D cochlea models. The cochleae with 

semicircular canals were uploaded to Sketchfab, a 3D model sharing platform. Uploading 

the models to Sketchfab allows the models to be available for other researchers and the 

public. Interactive 3D models allow the user to see the models from views chosen by the 

viewer, aiding with spatial learning and structural relationships. The Sketchfab interactives 

were added to the introductory page of the project. Further user feedback from target 

audiences on the interactive will improve the content of the final project in the future.  
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Conclusion	

            The cochlea is an intricate region of the auditory system that is often studied using 

animal models, however, there is a lack of clear visuals and educational material for 

cochlea comparative anatomy. The results of this project offer visual information on 

comparative mammalian cochlea anatomy and an introduction to hearing loss research in 

bats. The 3D models for the overview animation were based on novel segmented data and 

published references for accuracy. The animation and interactive provide users with new 

visual aids for understanding cochlea variation among species that cannot be easily 

obtained from raw data, literature, and histological slides. Students, researchers, and 

clinicians working in hearing research can use the interactive to learn or review anatomy, 

reinforce their past knowledge, and clarify the structure of the cochlea in three-dimensions. 	

            The presented methods and results describe a workflow for future 

biocommunication undertakings involving animation and interactive educational tools to 

teach comparative anatomy. The workflow covers micro-CT and histological slide 

segmentation, 3D model sculpting and repair, and 3D animation and interactive media 

creation. This novel web resource provides a platform to further enhance the understanding 

of the mammalian auditory system and reinforce the value of our profession through the 

transformation of complex data into clear visual communication material. 
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APPENDICES 

Appendix A: Wireframes for interactive  

 
Figure 55. Early interactive Wireframes. Preliminary design for interactive education module, 2D 
illustrations.  
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Figure 56. Early interactive Wireframes. Preliminary design for interactive education module, 2D 
illustrations.  



 

 73 

                   
Figure 57. Early interactive Wireframes. Preliminary design for interactive education module, 2D 
illustrations.  



 

 74 

 
Figure 58. Early interactive Wireframes. Preliminary design for interactive education module, 3D 
models.  
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Figure 59. Early interactive Wireframes. Preliminary design for interactive education module, 3D 
models.  



 

 76 

             
Figure 60. Early interactive Wireframes. Preliminary design for interactive education module, 3D 
models.  
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Appendix B: Storyboard for Overview Animation 

                      

 
Figure 61. Storyboard 1-2. Audio text not intended to be read. 

 
 

 
Figure 62. Storyboard 3-4. Audio text not intended to be read. 
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Figure 63. Storyboard 5-6. Audio text not intended to be read. 
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Appendix C: Adobe Animate code 

Buttons 

                        
Figure 64. Coding for pointers, Lines 71-89. Each annotation was coded as a pointer, this changes the 
cursor from an arrow icon to a finger pointing.  

 

 
Figure 65. Coding buttons to link to a website, Lines 319-332 and 417-420. These two buttons were 
coded to link to a different website. Every new link needs an additional underscore and number for the code 
to call.  
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Figure 66. Coding for Cochlea Structure Button, Lines 422-473. This button was coded to start the 
animated element when clicked using the code goToAndPlay(“start”); in line 436.  
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Annotations 

 

Figure 67. Coding for Annotations, Lines 810-854. Example of three cueing elements, “dots” and pop-up 
annotation code. Each cue was coded to call up a specific annotation and hide the rest. A total of 33 
annotations were coded. 
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